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1) Rechercher des astéroïdes à confirmer : 

 

à Etape 1 : Renseigner les informations sur son lieu d’observation : 

 

Avant de pouvoir réaliser chaque observation, nous devons connaître au préalable les 
coordonnées de l’objet en question. Nous allons donc rechercher des coordonnées 
d’astéroïdes non vérifiées sur le site du Minor Planet Center. Ce site, financé par la NASA et 
dirigé par l’union astronomique internationale (IAU), est responsable de la découverte de 
corps mineurs dans le système solaire (satellites, comètes, astéroïdes…). En se rendant dans 
NEO Services (comme ci-dessous) :  

 

 

Image 1 

 

Une fois que nous avons cliqué sur NEO Services, nous allons rentrer différentes 
informations sur notre lieu d’observation et notre matériel (Notons bien qu’ici, nous 
utiliserons une monture équatoriale et un télescope de formule optique de type Newton). 
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Image 2 

 

La première étape (RA Range et Decl.range) va être de remplir notre portée d’ascension 
droite et de déclinaison, cela dépend de l’endroit dans lequel nous observons, et plus 
particulièrement quelle portion de ciel nous pouvons couvrir avec notre matériel. Ces axes 
correspondent au mouvement du télescope tel qu’illustré ci-dessous : 

 

 

Image 3 
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Nous comprenons avec cette illustration que nous implantons dans le MPC, le champ (en 
degrés) que nous avons à notre disposition depuis notre site d’observation. Attention, il 
n’est pas toujours de 360° car des maisons, des arbres ou tout autre type d’obstacles 
peuvent nous obstruer certaines portions de ciel. Ici nous prenons 360° pour l’exemple.  

La deuxième étape (Magnitude Range) va être de renseigner la magnitude maximale jusqu’à 
laquelle notre instrument peut monter, pour l’exemple, nous prenons une magnitude de 1 à 
19, de manière générale, les astéroïdes du Minor Planet Center nécessitant des 
observations ne descendent que très rarement en dessous des 17. La magnitude dépend du 
diamètre du télescope et de la qualité du ciel sur notre site d’observation.  

La troisième étape va être de renseigner combien de degré nous pouvons couvrir par jour, 
ici il ne s’agit pas du champ auquel nous avons accès, mais combien de degrés est-il possible 
de couvrir pendant le temps de notre observation. Ici nous renseignons 200° pour 
l’exemple. 

 

 

Image 4 

 

Nous décidons aussi de trier les astéroïdes de sorte à pouvoir apercevoir en premier lieu 
ceux qui ont besoin d’être vérifiés. 
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à Etape 2 : Choisir l’astéroïde pour notre observation : 

 

 

Image 5 

 

Une fois tous les paramètres rentrés dans cette page, nous obtenons des noms d’astéroïdes 
à vérifier (ou non). Dans la première capture, il est intéressant d’apporter de nouvelles 
informations tandis que pour l’astéroïde 2012 BV13, il est indiqué que ce n’est pas 
nécessaire de l’observer pour apporter des précisions sur son orbite, cela reste tout de 
même intéressant à observer pour le plaisir. 
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Image 6 

En revanche l’astéroïde 2022 YS4 nécessite des précisions sur son orbite, nous pouvons 
alors le choisir comme cible. Mais avant, il faut déterminer à quelle heure et comment 
allons-nous pointer vers l’astéroïde. Nous regardons alors la colonne Date et UT pour 
identifier l’heure et la date de l’observation. Comme son nom l’indique, l’heure est donnée 
par l’horloge universelle, il ne faut pas se tromper. Il faut donc enlever 1 heure à l’heure 
française à la date de sortie du rapport. Les coordonnées d’Ascension droite et de 
Déclinaison sont données en fonction de l’heure. ATTENTION à la magnitude de l’objet ! De 
manière générale, un objet de magnitude 20 va être difficilement atteignable avec un 
télescope de 150mm ou plus, il faut donc éviter de choisir un astéroïde au-dessus de ce seuil 
et se retrouver avec des images ne révélant pas l’astéroïde. 

 

Une fois que notre objet est choisi, nous pouvons désormais passer à la partie plus 
pratique, la prise de vue. 
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2) Réaliser l’observation : 

 

Dans cette étape, nous verrons qu’il n’y pas de méthode particulière, cela dépend 
essentiellement du matériel utilisé. Il va falloir suivre les étapes de n’importe quelle session 
d’astrophotographie que nous avons pour habitude de pratiquer : 

Etape 1 : La mise en station 

Etape 2 : Le réglage du tube optique 

Etape 3 : La capture des images 

 

à Etape 1 : La mise en station : 

 

Il s’agit ici d’une mise en station pour les plus classiques :  

- Tout d’abord, il faut installer le trépied tel qu’il soit stabilisé, à l’aide du niveau à bulle sur 
le trépied, on s’assure qu’il soit parfaitement horizontal. 

- Nous installons le tube optique sur la monture. 

- Réglons la latitude en fonction du lieu d’observation, puis orientons l’axe d’ascension 
droite vers le NORD, pour pointer l’étoile polaire dans votre viseur polaire, une fois l’étoile 
polaire au centre du réticule de visée, la mise en station est terminée, nous pouvons lancer 
la motorisation.  
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Image 7 

 

NB : Si notre suivi n’est pas efficace, il se peut que notre tube ne soit pas bien placé, si 
lorsque nous bougeons notre tube de part et d’autre de l’axe d’ascension droite, un côté est 
plus « lourd » que l’autre, alors la masse est mal répartie. Il va falloir alors desserrer les 
anneaux autour du tube, et avancer ou reculer le tube. 

à Etape 2 : Le réglage du tube optique : 

 

- Tout d’abord, il va falloir faire la mise au point, à l’aide des très connus masque de 
Bahtinov. 
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Image 8 
 

Ce dernier va nous permettre de réaliser une mise au point parfaite, il va produire une 
légère diffraction de la lumière lorsque celle-ci passe à travers ses fentes. Nous allons 
ensuite avoir à toucher aux molettes de mise au point pour arriver à une figure de ce type 
en pointant une étoile brillante : 

 

 
Image 9 

 
Ici la mise au point est parfaite.  
 
Une autre étape va être la collimation du télescope, le principe est donc d’aligner les miroirs 
grâce à un laser. 
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Image 10 

 
 
Nous allons positionner le laser à la place de l’oculaire puis nous regardons si, sur la mire du 
collimateur, le point est parfaitement au centre :  
 

 
Image 11 

 
Si il n’est pas au centre, il va falloir venir jouer sur les vis situées derrière le miroir primaire 
pour le centrer. 

 
Image 12 
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Il va falloir ensuite regarder dans le tube, sur le miroir primaire directement, si le point 
rouge est au centre de la pastille située au centre du miroir primaire.  
 

 
Image 13  

 

S’il n’est pas au centre, nous allons alors toucher aux vis situées sur le support du miroir 
secondaire pour le recentrer. 
 

 
Image 14 
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Une fois ces étapes remplies, nous allons pouvoir passer à la capture des images. 
 
 

àEtape 3 : La capture des images : 
 
 
À présent, maintenant que le matériel est prêt, nous allons nous charger, pas à pas, de 
capturer les meilleures images possibles afin d’avoir un traitement et des informations 
résultantes, optimum.  
 
Voici une liste basique du matériel requis :  
 

- Un imageur.  
- Une bague d’adaptation compatible entre votre imageur et votre télescope. 
-  Un espace de stockage performant avec un espace libre de l’ordre de plusieurs Go 

minimum. 
 
Concernant l’imageur, il peut s’agir d’une caméra dédiée à l’astrophotographie ou d’un 
appareil photo de type reflex (les bridges et compacts sont à proscrire). Concernant le 
capteur employé par votre imageur, un capteur de type CCD est à favoriser car il se montre 
plus performant en basses lumières que l’autre grand type de capteur appelé CMOS. 
Cependant, sur le marché, la quasi-totalité des capteurs sont CMOS et peuvent très bien 
être utilisé à des fins astronomiques comme ici. Votre imageur peut être “défiltré” ou non, 
cela n'importe que peu. Notez bien que lors de l’utilisation d’une caméra dédiée, il est 
recommandé de ne pas utiliser de filtre pour observer nos astéroïdes, ils sont à l’origine 
d’une perte de signal qui peut entraîner une perte allant jusqu’à 1 magnitude. 
 
Vous allez commencer par retirer votre oculaire puis y installer l’imageur. Une fois que cela 
est fait, revérifiez votre équilibrage au niveau de la monture afin de garantir une prise de 
vue optimale. Allumez votre imageur et prenez le contrôle des réglages manuels.  
 

Nous allons maintenant voir ensemble notre but concernant l’image attendue et 
comment adapter nos réglages pour y parvenir :  

 
Nous cherchons une image nette où chaque étoile forme un unique point et non un trait de 
lumière. De plus, nous cherchons une image avec le moins de bruit possible mais où l’objet 
visé est toujours bien visible.  
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Alors, quels réglages faut-il faire ?  
 
Nous devons avoir un temps d’obturation le plus long possible afin de capter un maximum 
de lumière. Malheureusement, il y a une limite. En effet, les montures ne sont pas parfaites 
et malgré un suivi automatique de qualité, les étoiles vont finir par dessiner des traits. Il faut 
donc faire des essais avec différents temps d’obturation et trouver la valeur optimale. En 
général, 30s, 1 minute voire 2 minutes, cela dépend de l’astéroïde cible et de sa vitesse dans 
le ciel. 
Nous devons ensuite gérer la valeur ISO dans le cas d’un appareil photo, et le gain dans le 
cas d’une caméra afin de rendre notre appareil plus sensible au peu de lumière qui atteint le 
capteur pendant l’exposition. Le revers de la médaille de ce réglage est que des valeurs 
hautes produisent plus de bruit. Il faut donc régler l’ISO ou le gain en jugeant du rapport 
signal/bruit afin d’en trouver le meilleur compromis.  
Enfin, désactivez la balance des blancs automatique afin de vous éviter d’avoir des couleurs 
étranges après le traitement. N’oubliez pas de sélectionner le format d’image RAW (brut) 
comme .CR2 pour Canon ou NEF pour Nikon, par exemple. Pour les caméras dédiées à 
l’astrophotographie, il est recommandé de choisir des fichiers .FITS. 
 
Une fois que notre imageur est prêt, pointons notre cible et lancez le suivi automatique de 
cette cible par votre monture. Nous n’évoquerons pas le système d’auto-guidage ici. De là, 
lançons une série de prises de vue avec nos réglages. Il est recommandé, pour les reflex 
d’utiliser, soit un intervallomètre, soit un logiciel installé sur l’appareil reflex afin de lancer 
ses prises de vue automatiquement et à un intervalle régulier. Dans le cas du logiciel, le plus 
connu est Magic Lantern mais attention, nous déclinons toute responsabilité en cas de 
problème avec ce logiciel. Il n’est pas recommandé par les constructeurs.  
 
Concernant les prises de vue et leur nombre, la règle est qu’il n'y a pas de limite d’images. 
En effet, plus nous aurons d’images, meilleure sera notre image finale. Attention toutefois à 
ne pas surexposer nos prises de vue ou voir apparaître des blancs cramés sur certaines 
zones lumineuses de notre composition. Comptons environ 30 minutes minimum de temps 
d’exposition totale (somme de tous les temps de chaque prise de vue). 
 
Une fois que nous avons un temps d’exposition convenable, nous ne rangeons pas tout. 
Nous manquerions de passer à côté d'une étape fondamentale : les DOF ! 
DOF est l'acronyme de Dark-Offset-Flat. Ce sont des images particulières que nous devons 
produire afin de rendre notre image pleinement exploitable. Pour faire des darks frames,  
nous allons fermer notre tube avec son cache et continuez à prendre des photos (noires) 
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sans changer les réglages de l’imageur. Nous faisons ainsi au moins 20 images avec cette 
configuration et nous répétons l’opération à chaque session de prise de vue. Pour les flats 
frames, nous devons mettre devant notre tube une surface blanche et uniformément 
éclairée. Nous réglons notre imageur sur 100 ISO et nous affichons l’histogramme. Nous 
réglons maintenant l’exposition de notre imageur afin de remplir 2/3 de l’histogramme. 
Pour ce faire, nous modifions la vitesse d’obturation. Nous allons faire au moins 20 images 
que nous ne serons pas obligé de refaire à chaque session : En effet, lorsque les 
températures sont sensiblement les mêmes nous pouvons réutiliser nos DOF. Nous 
négligerons les offsets. Nous avons maintenant terminé notre capture des images. Nous 
récupérons nos images sur notre ordinateur, dans un dossier et nous trions les différents 
types de photos de manière à les retrouver facilement.  
 
Si vous êtes débutant ou peu initié et que certains termes ou localisation de réglages vous échappent, référez-
vous à votre manuel d’imageur.  

 
 
Nous pouvons passer à la suite pour traiter les images. 
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3) Traiter des images avec le logiciel Tycho : 

Nous allons utiliser le logiciel Tycho afin de pouvoir repérer et mesurer notre astéroïde sur 
les différentes photos prises lors de l’observation. Nous utiliserons pour cela un outil du 
logiciel nommé "Synthetic tracker". Notons qu’il nous faut un minimum de 11 images pour 
pouvoir utiliser cet outil. 

Sachez qu’avant toute chose, il est nécéssaire de renseigner les informations de 
l’observateur et du matériel, cela est donc spécifique à chacun, nous n’avons alors aucun 
conseil particulier pour renseigner ses informations. Pour ce faire, il faut cliquer sur 
"Settings -> Observatory" puis "Action -> Add Observatory" 

 

Image 15 

De même pour les informations sur l’observateur, rendez-vous dans "Settings -> Report 
Parameters" 
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Image 16 

 

à Étape 1 : charger et traiter les images 
 
Premièrement, nous devrons charger les images prises lors de nos observations. Pour ceci 
allez dans la fenêtre "Image manager -> List -> Add files (F2) " et sélectionnez l’ensemble à 
traiter. 

Dans la fenêtre principale située en "Action -> View Images (F3) ", une nouvelle fenêtre 
apparaît avec une visualisation des différentes images. 

Cependant, elles ne sont pas encore prêtes pour être étudiées. Nous devons donc les 
calibrer dans la fenêtre principale "Action -> express mode (F4) ". Une nouvelle fenêtre avec 
le titre de Express mode s’affiche par la suite.  
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La calibration va nous permettre 
d’ajouter des fichiers "Dark" pour 
enlever les bruits et des fichiers "Flat". Si 
on ne dispose pas de Flats on peut 
utiliser un Pseudo Flat qui a ses propres 
réglages mais ceux qui viennent par 
défaut sont normalement optimaux. 

 

 

 

Image 17 

 

 

 

"Calibrate": 

 

 

 

 

 

 

 

                                        Image 18 
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Pour aligner nos images, il existe 3 options 
différentes dont deux utilisant des 
programmes externes : utiliser les logiciels 
RegiStar et PixInsight ou un troisième 
interne au logiciel. Pour utiliser RegiStar 
ou PixInsight nous devons les avoir 
préalablement téléchargées pour coller le 
chemin à l’exécutable (.exe). 

 

 "Resize": 

                                                       Image 19 

                 

 "Align Images": 

                          
                         Image 20    

 
"Plate Solve"  
 
Avec cette option, le logiciel va localiser la correspondance entre nos images et le 
ciel en utilisant les étoiles les plus brillantes comme points de référence. Pour 
cela, nous avons trois options différentes, les deux premières peuvent être 
réalisées dans le logiciel. Nous pouvons importer nos fichiers sur un autre site 
pour la troisième option. Pour les deux premières on utilise la fenêtre "Plate 
Solve Images" : 

Avec Resize nous allons pouvoir 
modifier les dimensions de nos 
images. Soit en choisissant la 
longueur et largeur désirée ou en 
supprimant une partie verticale 
et/ou horizontale. 

 



 

 
 

  19 
 

                   
                    

           Image 21 

 

 

 

Image 22 

 

Sur " Advance Settings " choisir Tweak=2, activer le "CRPIX center" et pour " Downsample" 
suivre les explications du premier point. Télécharger la première image dans le logiciel.  

 

1) Utiliser le solveur proposé par Tycho qui peut être 
utilisé en ligne. On doit garder les valeurs par défaut. Si 
les images sont plus grandes que 4000x4000 pixels, on 
choisira alors un "Downsample factor" supérieur à 2. En 
revanche, si les images sont plus petites que 700x700 
pixels, on choisira un "Downsample factor" de 1. 
 
 

2) Utiliser le logiciel sans connexion interne sur notre 
ordinateur. Ce logiciel nous est proposé dans la page de 
Tycho (https://www.tycho-tracker.com/download) avec 
le nom de "Offline solver", qui est une version locale de 
Astrometry.net. Une fois sur notre ordinateur, ouvrir 
l’application et installer les index nécessaires suivant le 
champ de vision minimal et maximal. Revenir sur Tycho 
aller sur "Action -> Plate Solve Images" et coller le 
chemin au dossier "cygwin_ansvr". 

 

 

3)  Utiliser Astometry.net. 
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Image 23 

 

 

Une fois le processus terminé, télécharger la nouvelle image (cliquer sur new-image.fits)  et 
remplacer l’image que nous avions importé de notre dossier par la nouvelle. 

 

 

 

à Étape 2 : Attacher des éphémérides à l'ensemble de données :  

Aller vers Tools -> Download Observations depuis le menu principal. Tapez "2018 RB" pour 
le nom de l'objet et choisissez l'option "From obs database (confirmed object)". Cliquer 
ensuite sur "OK" pour continuer. Après un moment, une nouvelle fenêtre apparaîtra, "Text 
Form - Observations". Cette fenêtre devrait être remplie avec les observations pour 
l’astéroïde. 
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Image 24 

Cliquer sur le bouton dans le coin inférieur droit, intitulé "View in FindOrb". Le programme 
Find_Orb lancera et calculera l'orbite de cet objet en utilisant les observations du 
formulaire texte. 

 

Image 25 

Ensuite, ouvrir dans "Image Manager -> Ephemeris -> Attach Ephemeris from Database" 
depuis le menu "Image Manager".  

Dans la fenêtre qui s'affiche, double-cliquez sur l'instance appropriée de Find_Orb (si vous 
avez plusieurs instances en cours d'exécution, choisissez celle avec "2018 RB »). Maintenant 
on peut voir que les colonnes « EPH_ » sont remplies avec des informations sur l’objet. 

De plus, si vous défilez les colonnes vers la droite vous devriez voir la colonne qui indique si 
oui ou non l'objet est censé être dans le champ de vision pour chaque image. C’est utile car 
on exclut souvent les images qui ne se trouvent pas dans le champ de vision. (Il faut que la 
colonne indique « Yes » pour chaque image). 
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à Étape 3 : Exécuter le traqueur synthétique : 

Choisir "Action -> Synthetic Tracker" depuis le menu principal. Une nouvelle fenêtre 
apparaîtra, vous demandant le "Detection Sensivity Threshold (Seuil de sensibilité)". Un 
réglage de 50 % fonctionne bien ici. Si l’objet est extrêmement faible augmentez la 
sensibilité, une sensibilité plus faible permet des recherches plus rapides mais moins 
précises.  

 

Image 26 

Cliquez sur "OK" pour continuer.  

Vous pouvez entrer les paramètres de recherche dans la fenêtre qui apparaît. Puisqu'il s'agit 
d'une recherche d'un objet connu, et puisque vous avez joint des informations 
d'éphémérides au jeu de données, vous pouvez cliquer sur le bouton "Use Dataset 
Ephemeris" pour limiter automatiquement la recherche au mouvement de l'objet. La vitesse 
et la PA ont été limitées, comme illustré à l’image 25 se trouvant à la page suivante.  
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Image 27  

Cliquez ensuite sur « OK » pour lancer le traqueur.  

 

 

à Étape 4 : Analyser les images : 

La fenêtre « Track Navigator » devrait apparaître avec une liste des détections de l’astéroïde 
recherché. 

La cible d'intérêt devrait être dans les 10 meilleures pistes, (elles sont triées par « qualité ») 

Nous choisissons alors la piste n°1. Double-cliquez sur la piste 1 pour faire apparaître la 
fenêtre "Verify Track". Vous devriez voir le mouvement de l'objet dans la fenêtre "Image 
Viewer". À ce stade, vous pouvez continuer à générer des observations, valider ces 
observations et générer un rapport.  

 Si la cible n’apparait pas comme décrite ci-dessus (dans les 10 meilleurs choix), vous pouvez 
le rechercher dans la liste en allant sur "Find Object -> By Ephemeris" dans le menu « Track 
Navigator". Il va trier les pistes par proximité de l'emplacement prévu de l'objet tel que 
calculé par ses éphémérides. Il est aussi possible d’entrer les coordonnées manuellement 
dans "Find Object-> RA/Dec", puis il suffit de rentrer les informations données par le MPC 
dans la 1ère partie sur l’Image 6 par exemple. 
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 Dans les deux cas, les images seront triées par proximité d'un emplacement attendu. (Ce 
n'est pas parce qu'une piste semble proche de l'endroit où l'objet est attendu qu'il s'agit en 
fait de l'objet). Il faut effectuer une inspection visuelle ou générer des mesures qui peuvent 
être validées par rapport à d'autres observations. 

 

 

à Alternative à l’étape 3 : Utiliser les paramètres orbitaux pour trouver 
l’astéroïde 

Si nous avons assez d’informations sur l’astéroïde que nous analysons, nous pouvons 
utiliser ses paramètres orbitaux. Les paramètres orbitaux sont les éléments requis pour 
identifier de manière unique une orbite spécifique. Nous allons maintenant utiliser la 
fenêtre "Known Objects" en allant dans "File -> Load Known Objects" depuis le menu de 
la fenêtre “Image Viewer”. Elle permet de localiser des objets en fonction de leurs 
paramètres orbitaux. Celui-ci utilise le fichier "MPCORB.DAT" qui a été publié par le 
Minor Planet Center. 

Une autre façon de trouver l’astéroïde est de calculer ses paramètres orbitaux à partir des 
observations publiées, puis d'ajouter ces éléments au fichier "MPCORB.CUSTOM", qui est 
inclus dans la recherche régulière des autres astéroïdes. 

Pour ce faire, téléchargez les observations de l'objet ou copiez et collez les observations 
d'une autre source dans la fenêtre "Text Forms - Observations". Si vous souhaitez 
télécharger les observations, accédez à "Tools -> Download observations" dans le menu 
principal, spécifiez "2018 RB" (sans les guillemets), spécifiez "From obs database" 
(confirmed object) et cliquez sur "OK". 

Une fois que la fenêtre "Text Form - Observations" a été remplie avec les observations de 
l'objet, vous pouvez alors générer les paramètres orbitaux de celui-ci et les stocker dans le 
fichier "MPCORB.CUSTOM" en cliquant sur "Orbital Elements -> Modify MPCORB.CUSTOM" 
à partir de la fenêtre "Text Forms – Observations". Cela invoque le programme Find_Orb 
pour calculer l'orbite. Une fois que le programme a fini de s’exécuter, une nouvelle fenêtre 
apparaîtra montrant les objets stockés dans "MPCORB.CUSTOM". Vous pouvez ensuite 
enregistrer le résultat en allant sur "File -> Save from the menu" de cette nouvelle fenêtre. Il 
présentera un message indiquant que l'application doit être redémarrée pour que les 
modifications prennent effet. 
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Après avoir mis à jour le fichier "MPCORB.CUSTOM", vous pouvez maintenant accéder 
à File -> Load Known Objects à partir de "Image Viewer". Vous devriez maintenant voir 
deux instances de l'objet affichées dans la fenêtre "Known Objects". La première 
instance provient du fichier officiel "MPCORB.DAT"et la seconde (en bas de la liste) 
provient du fichier modifié "MPCORB.CUSTOM". 

À ce stade, vous pouvez cliquer sur l'entrée dans la fenêtre "Known Objects" qui se rapporte 
à l'objet et un "stack" sera automatiquement créée. A partir de ce "stack", vous pouvez 
ensuite double-cliquer sur l'objet pour le centrer dans le réticule. Après avoir réalisé cette 
étape, faites un clic droit dans la fenêtre "Image Viewer" et choisissez "Create Track – From 
Current Positions". Cela ajoutera une nouvelle piste à la fenêtre "Track Navigator". Comme 
précédemment, vous pouvez procéder à la génération d'observations à l'aide de ces 
informations de suivi. 

Si vous souhaitez supprimer l'élément de "MPCORB.CUSTOM", retournez à la fenêtre "Text 
Form - Observations" et choisissez "Orbital Eléments -> Modify MPCORB.CUSTOM". Cliquez 
ensuite sur l'élément et appuyez sur la touche "Suppr", ou faites un clic droit et choisissez 
"Delete" dans le menu contextuel. Enregistrez ensuite les modifications en allant dans              
"File -> Save" depuis le menu de la fenêtre "Orbital Elements [MPCORB.CUSTOM] ". 

 

 
à Approfondissement de l’étape 3 : Réglage des paramètres de recherche 

Vous avez maintenant appris à trouver un astéroïde en utilisant plusieurs méthodes : 
- Utilisation du traqueur synthétique avec des informations sur les éphémérides 
- Utilisation d'éléments orbitaux utilisation d'observations connues 

Toutes les approches ci-dessus nécessitent une certaine connaissance du 
mouvement de l'objet. Cependant, le traqueur synthétique peut être utilisé pour 
trouver un objet, même si son mouvement a une grande incertitude. 

Pour essayer cela, revenez à "Action -> Synthetic Tracker" et spécifiez le même seuil de 
sensibilité que précédemment. Ensuite, sur la dernière page concernant le "Synthetic 
Tracker Configuration", essayez d'élargir la recherche comme suit : 

Plage de vitesse limite : 1,50"/min à 2,50"/min 
 Plage limite PA : 200 à 300 degrés 
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Cela devrait donner environ 4500 vecteurs de mouvement. 

REMARQUE : Si vous spécifiez une limite supérieure de vitesse supérieure à la contrainte 
"Max Object Speed", vous devrez augmenter cette vitesse en conséquence. Il faut savoir 
que l'utilisation de "Dataset Ephemeris" augmente automatiquement la contrainte "Max 
Object Speed" si nécessaire, mais pas la saisie manuelle. 

Cliquez sur "OK" pour démarrer le traqueur synthétique avec cette recherche étendue. 
Cela peut prendre plusieurs minutes, selon votre configuration d’ordinateur. 

Lorsque le traqueur a terminé ses recherches, vous verrez les résultats affichés dans 
l’onglet "Track Navigator". L'objet doit toujours être affiché en tant que piste n°1 car il n'y a 
pas d'autres objets dans ce champ avec un mouvement similaire. Comme les résultats 
l'indiquent, le traqueur a pu trouver l'objet même avec une plage de recherche beaucoup 
plus large. Cela peut être utile lorsque l'orbite de l’astéroïde a très peu d'observations, 
comme il serait possible dans le cas d’une confirmation, car vous pouvez ouvrir les 
paramètres de recherche pour tenir compte de l'augmentation de l'incertitude. 

 

à Étape 5 : Création d’un rapport et envoi au Minor Planet Center 
 

Une fois vos mesures effectuées et vos résultats vérifiés, nous pouvons nous rendre dans la 
fenêtre "Observations - All Targets" qui contient les données de votre astéroïde qui sont les 
plus précises. Il faut alors générer un rapport au format MPC1992. Pour cela, il suffit d’aller 
dans "Report- > Generate MPC1992". L’image ci-dessous permet de voir le type de rapport 
que l’on peut obtenir. 

 

 

Image 28 
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Pour finaliser votre démarche, rendez-vous sur le site du Minor Planet Center puis dans 
l’onglet "Submit astrometric observations via a web form". 

 

Image 29 

Il ne vous reste plus qu’à rentrer vos données dans l’encadré adéquat. Vous n’avez pas 
besoin de rajouter des informations supplémentaires car Tycho s’est chargé de noter toutes 
les informations nécessaires, grâce au format MPC 1992, pour pouvoir les transmettre sur le 
site. 

 

Image 30 
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